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An Interim Style Guide for the US National Grid (USNG) version 1.11 

With ArcGIS Applications. 

 

Part I.  Introduction:  The purpose of this guide is to aid GIS analysts and cartographers 
in depicting the Federal Geographic Data Committee’s US National Grid standard 
(FGDC-STD-011-2001) on appropriate maps and planning graphics.  Users of this guide 
are strongly encouraged to first download and study the FGDC’s standard at  
http://www.fgdc.gov/standards/projects/FGDC-standards-
projects/usng/fgdc_std_011_2001_usng.pdf 
 
This guide was developed in response to identified needs of organizations, such as county 
GIS department, that are implementing the USNG.   It makes suggestions and offers a 
uniform convention for depicting the grid and other information, but is not a final 
authority.  Users of this guide are cautioned that map users have proven sensitive to the 
need for a consistent format in how the grid is labeled, where some digits are in 
superscript and others are in normal size, as demonstrated below and in the attached 
sample maps.  This document offers cartographic conventions which will aid map users 
by following a consistent standard.   
 
There are other variables that affect some aspects of how the grid is depicted and these 
can be modified for particular products.  These include map size (i.e. 8.5 x 11 inch or 21 
x 27 inch), scale (i.e. 1:2,400, 1:24,000, 1:250,000, etc), or purpose.  Furthermore, line 
weight, line spacing, and font size vary depending upon the scale of a particular map.   
On a small format map (i.e. 8.5x11 inches), the grid line labels internal to the map body 
might not be required.  Alternatively, on a large format map, two rows of internal grid 
labels may be used to facilitate use of the grid if the map is folded.  Other aspects of map 
layout can be modified by cartographers as required.  While the USNG is being 
implemented in software applications, the Military Grid Reference System (MGRS) 
referenced to WGS-84 or NAD-83 can serve as a USNG surrogate —ESRI software is an 
example of this.  The style guide was developed with ArcGIS 9.1.   
 
Users of this guide are encouraged to provide feedback via  
http://www.fgdc.gov/contact-info 
 
Attached sample maps: 

a. Style guide, 1:24,000 
b. Sample USNG Map, 1:500  
c. Sample USNG Map, 1:1,000 
d. Sample USNG Map, 1:500,000 
e. Sample USNG at Zone Junction Map, 1:50,000 
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Part II. ArcGIS Grid Wizard setup.  Part II is intended for use by GIS operators with a 
working knowledge of ArcGIS.  With ArcGIS, before making the map grid, load the data 
layers and make desired adjustments for color, shading, labels, etc.  Put map in Layout 
view and set to desired scale.   

1. To set map to a UTM coordinate system: 

A. Click the ‘View’ menu and click ‘Data Frame Properties.’ 
B. Click the ‘Coordinate System’ tab. 
C. Navigate to the ‘Select a Coordinate System’ window.  Follow the 

steps: ‘Predefined’ > ‘Projected Coordinate Systems’ > ‘Utm’ > ‘Wgs 
1984’ > ‘WGS 1984 UTM Zone XXY’, where XX is the UTM zone of 
interest and Y is the hemisphere of interest.  ***Note: In ArcMap, the 
‘N’ and ‘S’ associated with the UTM zones stand for ‘Northern 
Hemisphere’ and ‘Southern Hemisphere’ respectively.  Do not confuse 
them with the alphabetically denoted UTM bands.  Double click on 
desired UTM Zone and Hemisphere.  Click ‘Apply’.  Click ‘OK.’ 

 
If your map spans two UTM zones 
In some cases, a map may span two UTM zones.  Do not use the grid for 
one zone for the neighboring zone; they in effect are two separate grids 
(from a software perspective).  At this time, ArcMap does not make 
concessions for grid zone junctions.  USNG/MGRS files are available for 
download that show 1000-m grids and proper grid zone junctions.  (See 
www.fgdc.gov/usng)  The city of New Orleans, LA, is located at the 
junction of Zones 15 and 16, and is used as an example.  The grid files are 
loaded similarly to any other file in ArcMap.  Since the files are large, it 
may be a good idea to select the useful data and create that into its own 
layer.  To turn on the ladder labels for the grids, right click on the file 
name under ‘Layers.’  Find the ‘Text String’ subheading and click on 
‘Label’ in the dropdown menu.  Under the ‘Text Symbol’ subheading, 
adjust the ‘Font’ to Arial, ‘Size’ to 14, regular formatting, (no Bold, 
Italics, or Underline), and black.  Under ‘Other Options,’ click the 
‘Placement Properties’ button.  Click the ‘Placement’ tab, and ‘Under Line 
Settings’ > ‘Orientation,’ click on the ‘Horizontal’ radio button.  Click 
‘OK.’  This will need to be done for both grid files. 
 

2. To add a USNG in your list of personal styles: 

A.  Click the ‘Tools’ menu, point to ‘Styles,’ click ‘Style Manager.’   
B.  In the ‘Styles’ tree view to the left, click the name of the style file into 

which you would like to add a USNG style.  Comment: It does not 
seem to matter which style you choose.  Click the ‘Reference System’ 
folder.   

C.  To the right, click ‘MGRS Grid’ and click ‘Close.’  (If ‘MGRS Grid’ 
is not visible, right click in the white area on the right side of the ‘Style 
Manager’ box.  Click on ‘New’ and click ‘MGRS Grid.’  When the 
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‘Reference Systems’ box appears, click ‘OK.’  This will add the 
MGRS Grid option to the list of grids and graticules in the ‘Style 
Manager.’)   

D. The ‘Reference Systems’ window will open and have four tabs visible: 
‘MGRS,’ ‘Axes,’ ‘Labels,’ and ‘Lines.’  Click ‘OK.’  Close the ‘Style 
Manager’ window.   

 
3. To set up the ‘Grids and Graticules Wizard’ and load a 1000-meter grid: 

A. Under the ‘View’ menu, click ‘Data Frame Properties.’  Click the 
‘Grids’ tab.  

B. Click the ‘New Grid’ button.   
C. In the ‘Grids and Graticule Wizard’ window, click the middle radio 

button labeled ‘Measured Grid.’  In the ‘Grid Name’ window replace 
‘Measured Grid’ by typing in ‘USNG Grid.’  ***Note.  If clicking on 
the ‘New Grid’ button does not bring up the ‘Grids and Graticules 
Wizard,’ but instead brings up the ‘Reference System Selector’ 
window, then ArcMap is not configured to show wizards.  To enable 
wizards, cancel the ‘Reference System Selector’ window, then click on 
‘Tools’ > ‘Options.’  Select the ‘Application’ tab.  Check the box next 
to ‘Show Wizards when available.’  Click ‘OK.’   

D. Click ‘Next.’ 
E. Leave default ‘Appearance’ radio button as ‘Grid and labels.’ 
F. Under ‘Intervals,’ type in 1000 meters for both ‘X and Y axes.’  
G. Click ‘Next.’   
H. Click ‘Next.’ 
I. Click ‘Finish.’ 
 

4. The grid needs to now be configured in a MGRS format: 

A.  In the ‘Data Frame Properties’ window, a checked box next to ‘USNG 
Grid’ will be visible.  Highlight this line in blue by clicking it once.   

B. Click the ‘Style’ button.   
C.  The ‘Reference System Selector’ window will appear.  Click on 

‘MGRS’ on the left side.  Click ‘OK.’   
 

5. The grid is now ready to be manipulated to fit your purposes: 
 

A.  Back in the ‘Data Frame Properties’ window under the ‘Grids’ tab, 
double click on the ‘USNG Grid’ heading in the window.  In the 
‘Reference System Properties’ window, there will be four tabs visible: 
‘MGRS,’ ‘Axes,’ ‘Labels,’ and ‘Lines.’   

 
B. Click the ‘MGRS’ tab. 

1. Under ‘Ladder Labels,’ check the ‘Show a ladder of interior labels’ 
box, select 1 for ‘Rows and Columns,’ check the ‘Only show outer 
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rows and columns’ box, Arial Font, Size of 14, regular formatting 
(no Bold, Italics, or Underline), and Color black. 

2. If the map that you are making is a small enough scale (covers 100 
km2 or more), it may be necessary to adjust the ‘100,000 Meter 
Grid Square Identification’ to Arial font, size 18, regular 
formatting, and black.   

 
C.  Click the ‘Axes’ tab.  

1. Under ‘Major Division Ticks,’ check the boxes next to ‘Top,’ 
‘Left,’ ‘Bottom,’ and ‘Right.’  Click on the ‘Symbol’ box and 
make the color black and the width 1.00, and click ‘OK.’  Click the 
‘Display ticks Outside of the dataframe’ radio button, and make 
the ‘Tick size’ 5 pts. 

2. Under ‘Subdivision Ticks,’ check the ‘Top,’ ‘Left,’ ‘Bottom,’ and 
‘Right.’  Make the ‘subdivisions’ 5.  Click on the ‘Symbol’ box 
and make the color black with a width of 0.2, click ‘OK.’ Click the 
‘Display ticks Outside of the dataframe’ radio button and make the 
‘Tick size’ 2.0 pts.  Leave the ‘Border Properties’ as default 
Simple Border.’  

 
D.  Click the ‘Labels’ tab. 

1.  Under subheading ‘Label Axes,’ check the boxes for ‘Top,’ ‘Left,’ 
‘Bottom,’ and ‘Right.’   

2. Under ‘Label Style,’ choose ‘Corner Label’ from the dropdown 
menu.  Change ‘Font’ to Arial and ‘Size’ to 10, regular formatting, 
Color black, and ‘Label Offset’ of 12 pts.  Click the ‘Additional 
Properties’ button.  Click the ‘Corner Labels’ tab and check all 
four boxes.  Click the ‘Principal Digits’ tab.  Under ‘Secondary 
Font subheading, choose Arial from the dropdown menu, ‘Size’ 6, 
regular formatting and ‘Color’ black.  Under ‘Digits,’ choose 2 for 
‘Number of Principal Digits’ and 4 for ‘Number of Base Digits’ 
and click ‘OK.’ 

 
E.  Click the ‘Lines’ tab. 

1.  Click the ‘Show as a Grid of Lines’ radio button.  Click the 
‘Symbol’ box.  Make the ‘Color’ black and the ‘Width’ 1.0.  Click 
‘OK.’   

2. Click ‘Apply’ and ‘OK.’ 
 

6. To make a 10,000-meter grid on top of the 1,000-meter grid that you have 
already made, it is necessary to make an entirely different grid.  Bring up the 
‘Data Frame Properties’ window under the ‘View’ menu button. 

 
A. Under the ‘Grids’ tab, click the ‘New Grid’ button.  Click the 

‘Measured Grid’ radio button.  Click ‘Next.’   
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B. In the ‘Create a measured grid window,’ leave the default ‘Appearance 
Grids and labels’ radio button clicked.  In the ‘Intervals subheading,’ 
put in 10,000 meter for both the ‘X and Y Axes.’  Click ‘Next.’  Click 
‘Next.’  Click ‘Finish.’  

 
7. In the ‘Axes’ tab, under ‘Major Division Ticks,’ uncheck ‘Top,’ ‘Left,’ 

‘Bottom,’ and ‘Right.’  Under ‘Subdivision Ticks,’ uncheck ‘Top,’ ‘Left,’ 
‘Bottom,’ and ‘Right.’   

 
8. Under the ‘Labels’ tab, uncheck all four ‘Label Axes.’  Under ‘Label 

Orientation,’ uncheck all four ‘Vertical Labels.’   
 

9. Under the ‘Lines’ tab, turn on the ‘Show as a grid of lines’ radio button.  Click 
on the ‘Symbol’ box, and choose a color and width that fits your map 
purposes.  Note that these grid lines will go through the number labels that 
already exist, so the line width and color will need to be adjusted accordingly.  
Click ‘OK.’ 

 
10. Under the ‘System’ tab, turn on the ‘Use the data frame’s current coordinate 

system’ radio button.  
 

11. Under the ‘Intervals’ tab, under subheading ‘Interval,’ choose meters for 
‘Units’ and 10,000 for ‘X and Y Axes Intervals.’  Under the ‘Origin’ 
subheading, turn on the ‘Define your own origin’ radio button and set both the 
‘X and Y Origins’ to 0.  Click ‘Apply.’  Click ‘OK.’ 

 
Part III.  General Style Guide.  The following provides a general style guide for maps 
depicting the USNG.  Please refer to the attached sample style guide map as a visual 
template to accompany these narrative instructions.  The attached sample style guide 
illustration is designed to be printed at full scale on 21” x 27” paper.  Alternatively, it can 
be printed on 8.5” x 11” paper in black and white (see the note below the scale on the 
style sheet for this application).  In this description of map elements, selections from the 
attached map appear in a similar font style but are sized for illustration here and do not 
necessarily reflect their correct map specifications.   
 

1.  Title - Beginning with the information in the margins from top to bottom, the 
TITLE is in Arial font, bold, 24 point, all caps.  The subtitle of (USNG Demonstration 
Map) is in Arial font, 12 point.  
 

2.  Map Version - In the lower left is the map version in Arial font, 6 point.  
 

Title_USNG_STYLE_SHEET_DEMO_V1 
 

3.  Grid Information - To the upper right of map version, grid information is 
displayed in Arial font, 6 point, all caps, for example as: 
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 1000-m GRID, US NATIONAL GRID 
                                              NORTH AMERICAN DATUM 1983 
                                                                 GRID ZONE DESIGNATION 18S 

      100,000-m SQUARE IDENTIFICATION: UJ 
 
***In some instances, the map will cover more than one 100,000-m square zone.  In 
these cases, modify the above as the example that follows: 
 

1000-m GRID, US NATIONAL GRID 
                                              NORTH AMERICAN DATUM 1983 
                                                                 GRID ZONE DESIGNATIONS: 18S, 19S 

  100,000-m SQUARE IDENTIFICATIONS: 
    TJ, UJ, TH, UH   
 

4.  Grid Reference Box (GRB) - To the right of the grid information is the grid 
reference box.  Additional variations on this format are found in the FGDC’s USNG 
standard at Figure 4 or Appendix A in this document.  The style sheet provides examples 
of how to label the 100,000-m Square Identifications within the body of the map at 
Square intersections and along the neat line outside the body of the map.  Since the 
information in the boxes varies, the font size may vary.  Choose a font that best fits the 
box.  If a sample in Appendix A fits your situation, left click the box to select it and right 
click on the GRB.   Select ‘Grouping’ and click on ‘Ungroup.’  Next, click on the 
example letters and numbers in the GRB and edit them to fit your map.  Left click the 
box to select it and then right click, point to ‘Grouping’ and click on ‘Group.’  Once the 
GRB is to aesthetically pleasing, right click it and then left click the ‘Copy’ function.  Go 
to your map and click on the margin.  Right click the map margin and left click on 
‘Paste.’  The GRB may appear elsewhere on the map, so it must be dragged to the proper 
place.  Also, the GRB will most likely not be the proper size.  When it is selected, click 
and drag the corners and sides of the box to resize it.  If the GRB is sized to your liking, 
but the words inside are too small to read, delete the box, go back to the GRB in MS 
Word and increase the font size of the words.     

 
It is possible to make a GRB with the rectangle button in the lower left of the MS Word 
window.  Lines can then be drawn inside the box using the Line button to the left of the 
Rectangle button.  Click inside the box to type in the pertinent grid id information.  Click 
on each element of the box while holding down the Ctrl key, and right click.  Go to 
Grouping and click on Group.  Then copy and past the grid ID box to your map.   
 
                                                    
               Arial font, 6 point  
               Arial font, 5 point  
 
               Arial font, 7 point  
 
               Arial font, 5 point  
               Arial font, 6 point  
 
 

U.S. National Grid

 
100,000-m Square ID 

 
 

UJ 
 

 
Grid Zone Designation 

 
18S 
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5.  Scale Information - In the middle of the bottom margin is the scale information 
in Arial font, 9 point.   
    

Scale: 
1:24,000 (printed size: 21 x 27 inches) 
1:61,000 (printed size: 8.5 x 11 inches) 

 
6.  Scale Bar - Below the scale information is the scale bar.  Units of measurement 

for the USNG are in meters and label position is below the bar.  The extension scale (to 
the left of the 0) is divided into tenths to facilitate measuring a USNG grid coordinate.  
The primary scale (to the right of the 0) is divided into even units of 1,000-meters.  At 
various larger or smaller scales these may vary.  In this case there are four divisions after 
the zero, each of 1,000 meters and labeled as such.  There is one division before the zero 
with ten 100-meter subdivisions and labels for the 1,000 and 500 meter marks.  Labels 
are in Arial font, 7 point and are placed underneath the scale bar.   
 

1 0 1 20.5
Miles

1,000 0 1,000 2,000 3,000 4,000500 Meters

 
 
 

7.  Originator’s Organization - Below the scale bar is information regarding the 
map maker’s organization and contact information.  This is in Arial font, 6 point, caps.   
 

PREPARED BY: FAIRFAX COUNTY DEPARTMENT OF INFORMATION TECHNOLOGY 
GIS MAPPING AND SERVICES BRANCH, COMPILATION: FEBRUARY 4, 2004 

CORRECTIONS OR ADDITIONS SHOULD BE BROUGHT TO THE ATTENTION OF THE ABOVE ORGANIZATION 
PHONE: (703) 555-2712 

 
 

8.  Copyright - Below and to the left of the contact information, is the road data 
copyright information in Arial font, 7 point, caps.   
 
                                    ROAD DATA COPYRIGHT (c) 2005 NAVTEQ 
                                                       

 
9.  Weblink - To the right of the copyright information is a weblink for more 

information in Arial font, 5 point.   
 

For additional information: 
see www.fgdc.gov/usng 

 
10.  Declination diagram - Declination diagram and north arrow.  To the upper 

right of the scale bar is a declination diagram showing magnetic north, grid north and true 
north.  All of the text associated with this illustration is in Arial font, 6 point, caps.          
 
      To obtain accurate and timely magnetic declination information, it is necessary to 
enter the coordinates of the center of your map into a declination calculator.  These can 
be found online at the NOAA website at: www.ngdc.noaa.gov/seg/geomag/jsp .  Grid 
calculators show declination in degrees and minutes.  To determine the mil values from 
the angle values do the following:  
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- If the angle is in degrees, minutes, and seconds: 1.  Set DMS to represent the angle 
in degrees, minutes, and seconds respectively.  2.  Divide the minutes by 60, and the 
seconds by 3600.  3.  Add these two numbers to the number of degrees.  4.  Multiply 
this sum by 17.77777.  ie. [D + (M/60) + (S/3600)] * 17.77777.    
- If the angle is in decimal degrees, multiply by 17.77777.   
 

      To calculate grid north, it will be necessary to contact CSAT at (314) 263-4171.  
NGA CSAT can generate both grid north and magnetic north data, but it may take a short 
time to get the results back to the customer, so plan accordingly.  Information to provide 
NGA CSAT is the zone in which your map is located and the latitude and longitude of 
the center of the sheet.  In the future, NGA CSAT plans to provide an online calculator to 
allow customers to not only calculate magnetic north but grid north as well.   
 
      If your map spans two zones – as was mentioned earlier in this guide, it will be 
necessary to make two declination diagrams because grid north changes between 
adjacent zones.   
 
      Since the three arrows in the declination diagram are highly variable, there is no 
template.  It will be necessary to make your own.  One way is to go to the Paint program 
and draw a declination diagram using the line, pencil and magnifying tools that fit your 
map in terms of orientation of the three arrows.  It is possible to add text to the 
declination diagram while in Paint, but when it is pasted to the map, it often is illegible.  
After the declination diagram is drawn, use the Select tool to encircle the diagram and 
right click inside the selected area and click copy.  Paste the declination diagram to your 
map and resize and position it.  To add legible text to the declination diagram, click on 
the Insert menu button and then click on Text.  Find the text box on your map, double 
click it, and type in the pertinent information.   
 
 
 
                                                                                                                                                                                                                                          
                                                         2005                                                                            GRID CCONVERGENCE                                                                              
                                                           G-M ANGLE                                                                       1º 1' E (18 MILS)                                                                                          
                                                      9º 30' W (169 MILS)                            GN                                                                                                                                                    

                                                                                                                                                                 
                                                                                                                                                                                                                                          
                                                                                                  TO CONVERT A GRID 
                                                                                              AZIMUTH TO A MAGNETIC 
                                                                                             AZIIMUTH ADD G-M ANGLE. 
                                                                              
                                                                                             TO CONVERT A MAGNETIC 
                                                                                          AZIMUTH TO A GRID AZIMUTH 
                                                                                                SUBTRACT G-M ANGLE. 
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12.  Geographic Coordinates - At each of the four corners of the map depict latitude and 
longitude coordinates.  Use Arial font, 7 point, with all geographic abbreviations in caps:  
 

76º 41’ 3” W. 
 
The latitude and longitude coordinates of the cursor are visible at the lower right of the 
screen.  If units other than latitude and longitude are visible, go to View, open the Data 
Frame Properties window, click on the General tab.  Under the Units subheading, click 
on the Display dropdown menu and choose Degrees Minutes Seconds.   
 
13.   Labeling USNG grid lines.   It is critical to follow the below labeling formats.  The 
Grid Zone Designation and 100,000-m Square Identifications must be shown on a USNG 
gridded map.  Properly trained map users have shown great sensitivity to the labeling 
format.  Deviations from this format will cause map users to make mistakes in the use of 
grid coordinates.  For example, a grid line with the UTM value of  4356000mN  or with the 
USNG alpha-numeric format as 56 that is incorrectly labeled as 4356000mN or 4356 will 
cause users to make mistakes.  Subtle deviations from the USNG format can 
operationally have safety of life consequences. 
 
 In the map window, 1 km grid lines and ticks are 1.0 point (0.1mm) wide.  Ten kilometer 
grid lines and ticks are 1.5 points (0.25mm) wide.  Two-hundred meter ticks are 0.2 point 
wide.  The grid labels are Arial 6 and 10.  
 
1,000-m grid line labels along the edge of the neat line depict only the principal digits: 

57 
 

10,000-m grid line labels along the edge of the neat line depict the principal digits and 
preceding digits as superscript: 

4350 
 
Grid lines should be depicted on maps not closer than 20-mm and not further apart than 
100-mm (see FGDC-STD-011-2001, Table 2. Grid Spacing Recommendations.).   At 
map-scales larger than 1:10,000, grid lines should be depicted at 100, 10, or 1-meter 
intervals in accordance with the grid spacing convention.  An example of an exception to 
this is the attached 1:1,000-scale map.  It depicts a full grid with 50-m spacing and 10-m 
tics because of the small area covered: 
 

572  or   5723 
 
A full UTM value must be provided at least once on a map (lower left corner), and 
preferably on each corner: 
 

4356000mN 
 

The ladder labels that are within the map window are Arial font, 14 point, for example:  
 

57  or   572 
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The outer border is 1.5 points (0.15mm) wide. 
The ArcGIS software labels the grid lines automatically.  If you are making a map of a 
grid zone junction and have to import the grid files, labels exist for the grid lines, but they 
will have to be edited.  Once the grid files are brought in, select the necessary grid lines.  
To turn on the grid labels, right click on the file name and click on ‘Label Features.’  
Then right click on the date file again and click ‘Convert Labels to Annotation.’  The 
labels may not be in their final form and location, so put the map in data view to move 
and edit the labels.  The only labels that show up after hitting ‘Label Features’ are ladder 
labels.  Margin labels will need to be made manually.  This is done by having the map in 
layout view and Inserting text lines with the appropriate grid labels.  Since the grid labels 
must be typed in, pay special attention to the format rules mentioned above.   
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Appendix A.    
 

Example Grid Reference Box Options 
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